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CHAPTER
ONE

Installation

Before installing RAVEN, ensure any previous versions have been un-installed first.

Run the installation program. This will create a program folder called Convergent, with a sub-folder called RAVEN.
This folder can be accessed via the Start menu under Programs. The folder contains shortcuts to the program and
Uninstall program.

The program can be uninstalled by either running the Uninstall program from the RAVEN group, or using the
Add/Remove Programs dialog in the Windows Control Panel.







CHAPTER
TWO

Generating Data

2.1 Virtual Material Data

Virtual material data represents the property development of an isolated piece of a material, given a certain temperature
history. To create a virtual material simulation; click the first task, Create a basic simulation on the Common tasks
and reports window. If the window is not visible, select Show Feedback Window from the Window menu.

Common tasks and reports =

Common Tasks b3
t Create a basic simulation
+ Compare baseline results with a different cure cycle
+  Compare two materials with a single cure cycle

This task is very similar to selecting “New simulation” from the Data menu, or clicking the ¢ New simulation button
on the main toolbar, except they don’t automatically thin the simulation results. Many actions in RAVEN are accessible
in several different ways. You will be presented with the Create new simulation dialog.

Create new simulation
Simulation name: £54/3501-6 Prepreg Auto:
Material: A54/3501-6 Prepreg [v]

Cure cycle

Default Cycle

Qpen Cycle
Create Cuskom Cycle

[5et as RAYEM default cure cycle

Caniel

Select a material from the drop-down box, and enter a name for the simulation (or just leave the automatically generated
name intact). Now a cure cycle must be defined for the simulation. Click on Default Cycle to load the default cycle,
which will be shown graphically in the dialog. If the material has a default MRCC (Manufacturer’s Recommended
Cure Cycle) defined, it will be used. If not, the default RAVEN cycle will be used. See Creating/Editing Cure Cycles
for more information about cure cycles. Click OK to process the simulation. After a few seconds a default plot will
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appear with a both a Temperature vs Time and Degree of Cure vs Time series for the new simulation.

2.2 Thermal Profile Data

Thermal profile data represents the property development and thermal history of a stack of material layers subjected
to one (or many) thermal cycles throughout the material stack.

To create a thermal profile simulation; click the fourth task, Create a thermal profile simulation on the Common
tasks and reports window. If the window is not visible, select Show Feedback Window from the Window menu.

Although it’s possible to create a stand-alone thermal profile simulation (using the “* New simulation button), using
the thermal profile task automates several very common post-processing and plotting operations.

You will be presented with the Create new thermal profile study dialog.

Create new thermal profile study

Simulstion || post Processing

Marne: Thermal Profile Studsy

AC Cycles Mo Cycle Selected

T
B
@

undary
<« Material
Delete

Maove Lp

A
M
@
a
5

Mave Down

IMaterial Layer Properties

Boundary Layer Properties

Cancel

2.2.1 Simulation Tab

At the top of the tab, a name can be assigned to the study. Next, the autoclave (AC) cycle name is displayed, along
with a ... button which is used to assign the main cycle for the simulation. Unless otherwise specified using a local
cycle, all boundaries will use the autoclave cycle.

Since thermal profile simulation stacks can become quite complex, it is possible to save and open stacks to disk. This
is accomplished using the E Save Stack and E» Open Stack buttons (as well as one for £ Reset Stack).

A thermal profile stack is made up of a combination of “boundary” and “material” layers. A boundary layer defines
a location where heat transfer is controlled by a cure cycle, either with a given HTC, or a set temp (which forces the
temperature at that point to follow the cycle exactly). A material layer has a defined material, thickness, and initial
degree-of-cure (DOC). A stack can also have a single boundary layer set as the datum, which sets z=0 at that location.
If no datum layer is defined, z=0 is located at the bottom of the stack.

To insert a layer, click either the << Boundary or << Material button, depending on the layer type desired. A text
entry for the layer will be inserted in the list to the left of the buttons, and a visual representation of the layer will

4 Chapter 2. Generating Data
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appear on the right. The Delete, Move Up, and Move Down buttons can be used to manipulate layers in the stack.

Only materials with the models necessary for a thermal profile simulation will be available when selecting the material
for a material layer. When the selected material is changed, the initial DOC will update to reflect the suggested value
for the new material.

2.2.2 Post Processing Tab

This tab controls both the post processing actions performed on the simulation results, as well as the automatically
generated/updated plots for the thermal profile task.

Create new thermal profile study
Simulation || Post Processing |
Through-Thickness Queties Flats
Cycle Segment Boundaries ws Time:
[ specified Times: Time [
v Temperature
[1Time Segments Edit seqments Degree of Cure
Cure Rate
Specislized Plats Tq

Resin Modulus

Resin Poisson's Ratio

Resin Inst. Cure Shrinkage Factor {beta)

Resin Inst, CTE

Resin Wiscosity

Resin Density

Ply Modulus (L)

Ply Modulus {T)

Ply Modulus {TT)

Ply Poisson's Ratia (L-T)

Ply Pnissnn's Ratin 1 -TTY
Through-Thickness:

Time: ~

v Temperature (i

Degree of Cure

Cure Rate

Tg

Resin Modulus

Resin Poisson's Ratio

Resin Inst, Cure Shrinkage Factor (beta)

Resin Inst. CTE

Resin Wiscosity

Resin Density

Ply Modulus (L)

Ply Modulus (T}

Ply Modulus (TT)

Ply Poisson's Ratio {L-T)

Ply Prissnn's Ratin 1 -TTY

Temperature Rate vs Temperature

w

Cancel

In many cases, viewing the through-thickness distribution of a property at specific times is beneficial when performing
a thermal profile study. By default, the simulation results are queried at the start/end of the autoclave cure cycle
segments. Additional query values (times) can be defined as either a list of Specified Times, or using start/end/step
Time Segments.

Both Temperature vs Time and Temperature Through-Thickness are plotted by default. If different plot types are
desired, the variables of interest can be checked/unckecked in the corresponding lists. Depending on the materials
used in the thermal profile simulation, some of the values selected may not result in plots (since not all materials
output every property).

In addition, a specialized Temperature Rate vs Temperature plot can be toggled.

Chapter 2. Generating Data 5






CHAPTER
THREE

Importing Data

3.1 Importing a Workspace

Importing an existing RAVEN workspace (.rws) file will add the contents of that workspace to the existing RAVEN
workspace.

3.2 Importing Raw Data

Importing raw data in the form of a comma-seperated value file (.csv) or tab-delimited text file (.txt) will create a new
data object containing the imported data. A single plot will also be created, with the second data column plotted versus
the first data column.

The file to be imported can include any number of columns/rows of data. The last non-numerical line in the file before
the data begins is used to label the data columns (and must have as many entries as there are data columns).

3.2.1 Unit Systems

Currently RAVEN doesn’t associate units or data types with imported data. Therefore, all imported data is plotted
using the actual imported numeric values, and no unit conversion is performed (even if the RAVEN unit system is
changed).

Imported coordinates (as described below) are given types, since there is no question that they represent distance. If
coordinates are detected when raw data is imported, a prompt will appear asking which units the coordinates are stored
in. Since the length scale of interest for RAVEN work is often rather small; when plotting in SI, all coordinates are
converted to millimeters.

If a cycle is made using imported data, the unit system can be selected during cycle creation.

3.2.2 Coordinates

For the purpose of queries, it may be useful to define coordinates for the data columns. Coordinates are defined by
adding up to three (one for each of X, Y, Z) additional lines to the data file, prior to the column header line. Each
coordinate line must start by defining the coordinate being defined, using one of the labels “xcoord”, “ycoord”, or
“zcoord”. Next, a list of coordinates corresponding to the data columns is required. No coordinate value is given for
the first column (which usually represents ‘time’). Coordinate values can be empty for any of the data columns.

Example of acceptable CSV data file (the ‘AC Temp’ and ‘AC Pressure’ columns have no coordinates):
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xcoord, , 1.0,

zcoord, , 0.0,

Time, AC Temp, AC
0.0, 20.0, 101.3,
1.0, 24.0, 101.3,
2.0, 28.0, 101.3,
3.0, 32.0, 101.3,
4.0, 36.0, 101.3,

4

1.0, 1.0

0.5, 1.0

Pressure,
20.0, 20.
24.0, 22.
28.0, 24
32.0, 26.
36.0, 28.

0,
0,
.0,
0,
0,

Temp

3.2.3 Thinning/Smoothing

1,
20.0
.0

0

0

0

21

22.
23.
24.

Temp 2,

Temp 3

Once data has been imported, depending on the amount of data, a prompt may appear suggesting the data be thinned
(to improve performance while working with the data). There are two thinning methods provided. Data thinning can

be applied/removed at any time.

3.2.4 Updating Imported Data

There is currently no way to update/replace imported data in the workspace. It is very important to make sure your
raw data is correct before beginning to work with it in RAVEN, as if you need to re-import the data, you will have to
re-do all the analyses.

Chapter 3. Importing Data



CHAPTER
FOUR

Creating/Editing Cure Cycles

4.1 Default Cycles

Selecting Default Cycle may provide a different cure cycle, depending on the conditions at the time it’s clicked. If
the material (or materials, for a Thermal Profile Simulation) in use don’t have any MRCC cycles defined, the default
RAVEN cure cycle will be used. If MRCC cycles are defined, the default MRCC for the current material (or first
material, in a Thermal Profile Simulation) will be used.

Select cycle

Default Cycle m ¥ 1.0 C/min, hold @ 150 C 2 hrs
0.5 Cfmin, hold @ 180 C 2 hrs
Si C ‘with...
SEES R 1.0 Cjmin, hold @ 120 C 2 hrs
Copy Cycle From... 0.5 Cfmin, hold @ 120 C 2 hrs
1.0 Cfmin, hold @ 120 C 1 hr, hold @180 2 hrs
Create Cuskorn Cycle
Cyicle From Data,, .

RAVENM default cure cycle

[15et as RAYEM default cure cycle

To force the use of a specific MRCC cure cycle, or the RAVEN default cure cycle, click on the down-arrow next to the
Default Cycle button to get a list of MRCC cycles currently available.

Be careful when changing materials after selecting a default cure cycle, as the cycle will not change to reflect the
default cure cycle for the new material.

4.2 Sharing Cycles

Selecting Share Cycle With... will display a list of all cure cycles currently in use in RAVEN (as well as which
simulation is using the cure cycle). Select a cure cycle and click OK. The shared cure cycle can now be edited while
modifying any simulations which share the cure cycle, and all simulations using it will update as needed.

4.3 Copying Cycles

Selecting Copy Cycle From... will display a list of all cure cycles currently in use in RAVEN (as well as which
simulation is using the cure cycle). Select a cure cycle and click OK. The copied cure cycle is in no way connected to
the source cure cycle, and edits made will only affect the current simulation.
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4.4 Using Saved Cycles

Selecting Open Cycle will display a file selection dialog, where you can select either a RAVEN cycle file (.rcf), Legacy
COMPRO cycle file (.cyc) or Comma-Seperated Value file (.csv).

4.5 Custom Cycles

Selecting Create Custom Cycle will display the Cure Cycle Editor with an empty cure cycle. See Using the Cycle
Editor for more information on editing cure cycles.

4.6 Cycles From Data

Creating a cure cycle from data already in RAVEN can be used to quickly predict the property development of a
material given imported experiemental thermal history.

The Cycle From Data... button is only available if valid data to create a cure cycle is present in RAVEN. Clicking
this button brings up a dialog where you can select the source simulation, results entry, as well as which data columns
to use for the time and temperature of the cure cycle.

Create cure cycle from data

Source: .analysis group 1 = ...4/3501-6 Prepreq

Results: Simulation resulks v
Time: Time w
Temperature: | Temperature I

Irnported Data Units

Update cycle when source data changes

[ OK ] [ Cancel ]

If the results selected for the source data are imported results, it will be possible to specify the time and temperature
units of the source data.

By default, cure cycles created from data will update if any changes are made to the source data used to create them.
You can disable this by unchecking Update cycle when source data changes.

4.7 Editing Cycles

Selecting Edit Cycle will display the cycle editing dialog. See Using the Cycle Editor for more information.

10 Chapter 4. Creating/Editing Cure Cycles



CHAPTER
FIVE

Using the Cycle Editor

5.1 Overview

The cycle editor is used to create and manipulate cycles for use with RAVEN.

<2 Cure Cycle Editor g@

Eile Help

Cycle Name: | pefault cure cycle Default cure cycle
Temperaturs 200

Initial ternperature of 20 °C
o o

e ,

Rarrp to 20 °C &t 5.00 °C/min 150

Temperature (°C)
S
=)

Appk
00 50 100 150 200 250
Time (min)

There are three types of cycles supported by the cycle editor; Simple, Advanced, and Tabular.
» Simple cycles are segment-based (meaning they’re made up of ramps and holds), and only have a temperature
history.

* Advanced cycles are also segment-based, but in addition to temperature history, allow for pressure and vacuum
history. Unlike simple cycles, they also support lead/lag control.

* Tabular cycles don’t use segments, and instead use a precise time/temperature/pressure/vacuum history. Tabular
cycles don’t allow for lead/lag control.

5.2 Editor Modes

The editor can be used in two different modes.

The first mode (single-cycle mode) involves clicking on one of the buttons on the Create/Edit run dialog, such as
Open Cycle, Create Custom Cycle, or Edit Cycle. This launches a single-cycle editor, used to define the cycle for a
single run. Clicking OKk in this editor accepts the current cycle.

11
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Select cvcle

Default Cycle  [fv

Default cure cycle
200 - T T T

@
=]
T

Qpen Cycle
Create Custom Cycle

Temperature (C)
=]
o

(44
(=)
T

0 50 100 150 200 250
Tome (i)

[5et as RAYEN defaulk cure cyele

The other mode (multi-cycle mode) is accessed from the Tools menu. The cycle editor launched in this manner is
used to modify all the cycles currently being used in RAVEN. Clicking Apply in this editor re-calculates simulations
using the current cycle in RAVEN.

File Edit Data Plots Toaols Options ‘Window Help

Cure Cyele Editor
Materials Manager
Create Process Maps

5.3 Segment-Based Cycles

There are three types of segments in a segment-based cycle. There ramp and hold segments, as well as a single initial
value segment. Initial segments can’t be manually inserted, so one is automatically created when you insert a ramp or
hold segment to an empty cycle.

Temperature

Initial termperature of 20 °C
Ramp to 180 °C at 2.00 @C/min .

Hold for 120 min
Ramp to 20 °C at 5.00 °C/min

Options

5.3.1 Adding/Removing Segments
Ramps and holds are inserted by selecting an existing segment in the cycle (if any exist), and clicking the << Ramp or
<< Hold button. The new segment will be inserted after the selected segment, and the new segment will be selected.

Segments can be selected either by clicking in the segment list on the left, or clicking on the visual display of the cycle
on the right.

To delete a segment, select the segment and click Delete.

Segments can be moved up and down in the list by selecting the segment, and clicking the Move Up or Move Down
button.

5.3.2 Editing Segments

Segments can be edited in two ways; direct text entry, or curve dragging.

12 Chapter 5. Using the Cycle Editor
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To enter specific values for a segment, double-click the segment in the list. Editable values will become text boxes,
where you can enter new values for ramp rates, target temperatures, etc. To accept the changes, press enter or click
elsewhere on the segment list.

Temperature

Initial temperature of | zo.ol  oC
Ramp to 180 °C at 2,00 *Z/min
Haold for 120 min

Rarnp to 20 °C at 5.00 *C/min

You can also alter segments by clicking and dragging the plotted curve of the cycle. The values adjusted depend on
what type of segment is selected, and where on the curve you click. The possible combinations, and the adjustments
allowed are:

* Initial - Adjust the initial value
e Ramp (mid-line) - Adjust the ramp rate

* Ramp (end point) - Adjust the ramp rate and target value

Hold (mid-line) - Adjust the target value of the previous segment

Hold (end point) - Adjust the hold time

Default cure cycle

200 T T T T T T T

o
=]

Temperature (°C)
=]
o

(4]
o

0 50 100 150 200 250 300 350 400
Time (min)

When modifying segments by dragging, a solid blue line displays the cycle based on the cursor position, a dashed
green line displays the original cycle, and a dashed pink line displays what the cycle will snap to if the mouse button
is released. The cycle will snap to values which can be defined in the options dialog, as well as to the original values
for the segments being adjusted.

5.4 Tabular Cycles

Currently, the only way to enable tabular cycle mode is to load a legacy COMPRO CYC file stored in tabular format,
or load data from a CSV file.

For CSYV files, the importer treats any line where the first comma-seperated value is a float as a data line, and expects
data in the order: time, temperature, pressure, vacuum. Time and temperature are necessary, whereas pressure and
vacuum are optional.

5.4.1 Adding/Removing Points

Data points cannot be added or removed in tabular mode.

Chapter 5. Using the Cycle Editor 13
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5.4.2 Editing Points

To edit a data point, double-click the cell in the data grid. Clicking points on the plotted curve will highlight the
corresponding cell in the data grid. Dragging of data points is not supported in tabular mode.

5.5 Options

The options dialog is used to adjust various parameters in the cycle editor. The dialog can be accessed by clicking the
Options button in the editor window.

Options
Current Cycle Type
i () advanced

Current Cyele Unik Type

®s=1 QOuscs
Snap Settings

Tirne: {mir) 5.0
Temperature (°C) 5.0
Rate {*C{min} 0.25

Default Segment Yalues

Iritial Temperature (*C) 20.0
Ramp Target Increment (*C) [5p.0
Ramp Rate (°C/min) 1.5

Hald Tirne: {mir) 50.0

[5ave as default

[ Ok ] [ Cancel

5.5.1 Current Cycle Type

When editing a simple or advanced cycle, it is possible to switch between the two modes. Tabular mode can only be
enabled by opening a saved tabular cycle. When in tabular mode, switching to simple or advanced mode is done by
resetting the cycle (from the file menu, or clicking the Reset Cycle button), or by opening a saved simple/advanced
cycle.

When using multi-cycle mode, this setting applies to the current cycle.

5.5.2 Current Cycle Unit Type

This selects the unit system used to display/edit the cycle. This will not affect the units used to display results in
RAVEN.

When using multi-cycle mode, this setting applies to the current cycle.

5.5.3 Snap Settings

These values determine the snap values used when dragging curves in segment-based cycles.

When using multi-cycle mode, this setting applies all active cycles.

14 Chapter 5. Using the Cycle Editor
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5.5.4 Default Segment Values

These values are used when inserting new segments in segment-based cycles. Initial Temperature, Ramp Rate,
and Hold Time define the default values for segments which require said parameters. The Ramp Target Increment
defines how far above the current segment’s end value the default target for an inserted ramp will be.

When using multi-cycle mode, this setting applies all active cycles.

Checking the Save as default checkbox and clicking okay will save the snap settings and default segment values to
the RAVEN configuration file for future sessions.

Chapter 5. Using the Cycle Editor 15
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CHAPTER
SIX

Creating/Editing Plots

6.1 Creating a Plot

Plots are the primary means of visualizing data in RAVEN.

To create a plot, click the 2 New plot button on the toolbar.

New Plot: Create Series
General
Hamme: Temperature Auto:
Source Data
Analysis: AS4)3501-6 Prepreg v

Axis

W-ais datal | remperatire _V_E] 1 v
H-adis data: [ qime Y'E] 1 |
Fatrnakting

[ use group-defined Format

Colour: I

Line weight:
Line style: v
Marker style: v

I K l [ Cancel ]

Everything necessary to create a plot with a single series (usually Temperature vs Time) will be set by default. The
name of the initial series, as well as the source analysis and data columns can be adjusted. The format of the series is
also editable.

To create a plot with multiple series, click the ... button beside either the Y-axis data or X-axis data. This will allow
the selection of several data columns, and a series will be created for each selected column versus the single opposing
data column.

When multiple data columns are selected, checking the “rotate” checkboxes for axes or formatting will increment the
checked selection for each series created. If the checkboxes are not selected, every series will be created on the same
axis, or with the same formatting options.

6.2 Editing a Plot

To edit a plot, double-click the plot item in the plot tree. The Plot Options dialog will be shown.

17
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Plot Options

Axis Labels

Plok Marne:
Flot 1

Unik Syskem

@ Default O)sI Ouscs

[ show legend
Show gridlines
[ petailed series labels

[ 04 H Caneel ]

This dialog allows you to adjust various attributes of a plot, including the name, legend, gridlines, and automatic series
label types.

All plots are created with the Default unit system, which means they will use whichever unit system RAVEN is
currently set to use. If a plot is manually set to either SI or USCS, it will display using that unit system, regardless of
the system RAVEN is set to use.

The Axis Labels tab allows you to override the automatically generated names for the various axes on a plot.

6.3 Adding Series

To add a series, right-click on a plot frame and select New Series.... The Create Series dialog will be shown, which
is nearly the same as the dialog used to create a plot.

Create Series
General
Mlarne: Degree of Cure Auto:
Source Data
Analysis: A54)3501-6 Prepreg ™

Axis

f-axis data: Degree of Cure v E] 3 w
weais data: | qime ™ E] 1 [ae]
Faormatting

[ use group-defined Format

Calour: I | |
Line weight: v
Line skyle: v
Marker style: v
I Ok l [ Caneel ]

6.4 Editing Series

To edit a series, double-click the curve on the plot itself. This will display the Edit Series dialog.

18 Chapter 6. Creating/Editing Plots
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Edit Series
General
Marme: Degree of Cure auto:
Source Data
Analysis: AS54/3501-6 Prepreg v
Axis. i
f-axis datdi | pegres of Cure 2 |
weais data: [ Tine 11
Farmatking
[ use group-defined Format
Coou: | I
Line weight: v
Line skyle: v
Marker style: v
[ OK ] [ Canicel ]

This dialog is very similar to the dialog used when creating plots/series, except without the ability to manipulate

multiple series at once.

6.5 Viewing Data on Plots

Plots can be interacted with in a variety of ways. The main toolbar has several icons to ease navigatiion on plots.

4 Zoom window
@ Probe tool

% 2 Zoom Extents
4 Zoom in
< Zoom out

ries

Button Function
¢ Select Tool Selecting plot items (spacebar)
& Pan Tool Pan around the plot (p)

Zoom the plot using a bounding box (z)
Used to extract data values at a specific point on a se-

Zoom to the extents of the data (x)
Zoom the current plot in (+)
Zoom the current plot out (-)

In addition, various plot components (such as the axes and labels) can be manipulated by double-clicking or right-

clicking on them.

Chapter 6. Creating/Editing Plots
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CHAPTER
SEVEN

Smoothing/Thinning Data

7.1 Smoothing Data

At the moment, RAVEN implements two data smoothing routines. One routine uses an averaging window that has a
specified data-point width, and the other routine is context sensitive and averages over a specified data width.

Data smoothing

Smoothing Algorithm

(%) savitzky-Golay digital smoothing palynomial Fileer (Fast)
Polynomial order 4

Window size (points)
{must be odd number, larger than order+2)

() Context sensitive moving window average (slow)

I Ok l [ Caneel ]

7.1.1 Savitzky-Golay digital smoothing polynomial filter

The first algorithm is a Savitzky-Golay digital smoothing filter !. This is also called a least-squares filter 2, or a Digital
Smoothing Polynomial filter 3. Essentially the filter fits a polynomial of order 7 to all the data within a window of
width w for each data point. Due to the formulation, w must be an odd number, and larger than n+2. At the two “ends”
of the data, data is mirrored to satisfy the data window for the algorithm. Details of the algorithm can be found in
Numerical Recipes #. The algorithm is quite fast as it assumes equally spaced data and uses linear algebra to perform
the least-squares fitting.

7.1.2 Context-sensitive moving window average

The second algorithm operates in the same space as the data. This requires that the base data be monotonic: either
increasing or decreasing with no duplicates. The base data can be any data column that satisfies this requirement. The
smoothing window is then specified in terms of this data column. For example, if “Time” is specified as the base data,
the window might be “10 s”. If temperature is the base data, the window might be “2 C”. The smoothing algorithm

I'Savitzky, A., and Golay, M.J.E., 1964, “Smoothing and Differentiation of Data by Simplified Least Squares Procedures”, Analytical Chemistry,
V. 36, pp. 1627-1639.

2Hamming, R.W., 1983, Digital Filters, 2nd Ed., Prentice-Hall.

3Ziegler, H., 1981, “Properties of Digital Smoothing Polynomial (DISPO) Filters”, Applied Spectroscopy, V. 35, pp. 88-92.

4Press, W.H., Teukolsky, S.A., Vetterling, W.T., Flannery, B.P, 2007, Numerial Recipies: The Art of Scientific Computing, 3rd Ed., Cambridge
University Press
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then takes the mean of the data across the data window for each data point. The algorithm preserves the number of
data points in the data set. As such, the beginning and ends of the data are less averaged than the middle due to the
averaging window being clipped. This algorithm is quite a bit slower than the Savitzky-Golay algorithm.

7.2 Thinning Data

Thinning data is generally used on larger data sets, in order to improve plotting performance. There are three thinning
methods currently available in RAVEN; Convert to Grid, Arbitrary Row Reduction, and Maximum Delta.

Data gridding and thinning

Thinning algorithm
(3) Convert to grid {interpolates and extrapolates)

Grid base data Time v
Start value 1.0 Auto:
End value 26130.0 Auko:
Step value 26,13

() Arbitrarily reduce data size to n rows

Original data size! 25134 Thinned data size: |1gog

[ K ] [ Cancel ]

7.2.1 Convert to Grid
The Convert to Grid thinning method interpolates and extrapolates the data to obtain values at fixed step intervals over
a given range. The data column used as the basis for the stepping must be monotonically increasing, and only valid

columns are shown in the dialog. The data extents for the selected base column are shown and used as the default
range (but can be adjusted if needed). The default step value will result in 1001 data points.

7.2.2 Arbitrary Row Reduction
Arbitrary Row Reduction thinning does no interpolation or extrapolation, and simply extracts evenly spaced data rows

over the full data range to obtain the total number of rows specified. For instance, if the original data is made of 1000
rows, and the specified target is 500 rows, the thinning data will contain every second data row.

7.2.3 Maximum Delta

The Maximum Delta thinning method is not currently implemented.
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CHAPTER
EIGHT

Querying Data

8.1 Single-Result Queries

Single-result queries extract data across a selection of columns in a single result entry for a selection of values in a
given column. These queries are well-suited to querying imported data made up of multiple columns of the same
variable at different locations, in order to obtain curves of that variable over a length or through a thickness.

To create a single-result query, click the =} New query button, and select Single-Result Query. If the button is not
visible, you will have to enable Expert Mode, as queries are only available in Expert Mode.

Create Single-Result Gtuery
General
Mame: Query 1
Group: Analysis group 0 v E]
Source data
Source: ..analysis group 1 > Imported Data E]
Results: Imparted data v
Data columns: Time

v Temperature 1
Seleck ¥ Temperature 2
¥ Temperature 3

¥ Temperature 4

Selection filker: Temp
Display name: Temp
Sork by z || |Mane || | Mane hdl

Query Details

Query by: Tirme |
Range: 0.0 ko 25.0
Yalues: List: 0,5,10,15,20,25

D Segments Edit segments

[ all data rows (263

[ Ok l[ Cancel ]

After naming the query and selecting the data source, the query parameters must be defined. The data rows to be
included in the query can be manually selected, fully selected/unselected with the All and None buttons, or filtered by
entering text in the Selection filter. If a valid regular expression is detected in the filter box, it will be used to select
items. Otherwise, all items with the entered string somewhere in their name will be selected (case-insensitive).

The Display name is optional, and may affect automatic series names when plotting the query results (depending on
series naming settings). If valid coordinates exist in the source results, the query results can be sorted by up to three
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coordinate values, as selected using the Sort by drop-downs.

Query Details allows selection of the column to query by (usually ‘“Time’), and provides three means of defining the

values at which to query. The data range of the selected column is shown for reference.

8.2 Multi-Result Queries

Multi-result queries extract data across all columns for a selection of results entries for a selection of values in a given
column. These queries are well-suited to querying thermal profile simulation data made up of multi-variable results,

each having different coordinates.

To create a multi-result query, click the =@ New query button, and select Multi-Result Query. If the button is not
visible, you will have to enable Expert Mode, as queries are only available in Expert Mode.

Create Multi-Result Query

General
Marme:

Group:

Source data

Source:
Analysis:

Resulks:

Select

Query Details
Query by:
Range:

Values:

Selection filker:

Query 1

Analysis group 0 v E]
...analysis group 1 E]
Thermal Profile Study v
¥z = 10.0 mm ~|
¥z =9.375mm
¥ z=08.125mm
¥z = 6,875 mm
¥z =5.625mm
¥z =4.375mm |
Tirne Il
0.0 - 360.0
Lisk: 0,50,100, 150,200, 250
|:| Segments Edit segments

[ ok

l [ Cancel

]

Unlike single-result queries, multi-result queries require you to select a number of analysis points from a given set of
results. The Query Details are defined in the same manner for both query types. Refer to Single-Result Queries for

more information.
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CHAPTER
NINE

Printing

9.1 Printing Plots

To print a plot, select the plot item in the Plot Tree, and select Print current plot... from the File menu. The layout of
the plot can be adjusted (Page Setup), and previewed by selecting Print preview (current plot)... from the File menu.

9.2 Page Setup

To setup the page layout for printing, select Page Setup... from the File menu.

Page Setup
Crrientation Margins {mm})
(&) Partrait Left: |15 Right: | 15
® L anisen: Top: |15 Baottom: | jg
Centering Scaling
Horizantal Adjust bo: | 100 | % of fitted size
wertical
[ ok 1 [ Cancel ]

This dialog allows adjustments to the paper orientation, margins, centering, and overall plot scaling. By default, all
printed plots are scaled to fit the page (withing the margins and maintaining the original aspect ratio). A scale value of
100% maintains this size, while higher/lower values result in a zoomed plot image.
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CHAPTER
TEN

Process Maps

Process maps are complex plots used to describe both how a given material state (in Degree of Cure vs Temperature
space) can be reached, as well as the material properties at that given state.

The Process Maps dialog allows creation of a set of process maps for a material. There are three basic map types avail-
able; isothermal, dynamic and material property maps. All process maps are plotted in Degree of Cure vs Temperature
space.

Process Maps
General | Jsothermal | Dynamic | Cure Rate
. Map Types

Material: | A54)3501-6 Prepreg v
Isathermal

Isathermal Temperature Resolukion: 5.0 Drynamic
Drynamics Overlayed on Isothermals

Plat Minimum Temperature; 20 . i i
¥ Cure Rate ~

Plat Maximum Temperature: 200 Resin Modulus
Resin Inst, Cure Shrinkage Factor (beta)
Resin Inst, CTE
Resin Yiscosity
Resin Density
Resin Heat: Capacity
Ply Modulus (L)
Ply Shear Modulus (L-T}
Ply Effective Cure Shrinkage Factor (L)
Ply EFfective Cure Shrinkage Factar (T)
Ply EFfective CTE (L)
i ges

Appa——".

e

Generate Maps

The general tab of the process map dialog controls global map settings, as well as which maps will be generated.
All maps will be generated for the material selected here. Isothermal process maps are generated by querying across
multiple isothermal virtual material runs. The Isothermal Temperature Resolution value determined can be used to
increase the data density of isothermal process maps. For consistency, all process maps will have their temperature
axes ranges set to the values defined in the Plot Minimum/Maximum Temperature entries. The degree of cure axes
ranges are automatically set from O to 1.

Selecting the Isothermal and Dynamic checkboxes will create tabs to further define those map types. Selecting
Dynamics Overlayed on Isothermals will create combined versions of any/all isothermal and dynamic maps gener-
ated. Depending on the material selected, several material properties will available for map creation. Checking the
corresponding checkbox will create a tab for additional map details.

10.1 Isothermal Maps

Isothermal maps are made up of curves of constant time. Generally there will be several sets of curves for different
time ranges. For example: curves from lmin to 10min (Imin increments), curves from 10min to 60min (10min
increments), and curves from 60min to 360min (60min increments). Since the cure rates of most materials slow as
they approach full cure, this approach is used to space out the time contours as cure progresses.

Each individual map tab has a minimum and maximum temperature value, which defaults to the plot mini-
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mum/maximum on the general tab. These values can be used to calculate map data outside the plotted range, which

may be necessary for some materials.

Process Maps
General | Isothermal |Dynam|c Cure Rate
Stark {min} End {min) Step {min) Colour ‘Weight Style Marker
: o ! (] [ —— [] [ =[] | ¥
10 &0 10 [ — | | (o] [=emee ]| [v]
50 30 &0 (— ] [l | Il | vl
Min Temp: | 20 Max Temp: | 200 [ Add Segment ] [ Delete Segment: ]

10.2 Dynamic Maps

Dynamic maps are made up of curves starting with different initial degrees of cure, and heating at a constant rate over
the temperature range of interest. Unlike isothermal maps, each rate value defined in a segment will result in an entire
plot (not just a set of curves on a single plot). The example shown below would generate a dynamic process map at

0.5 C/min, 1.0 C/min, and 1.25 C/min.

Process Maps
General | Isothermal | Dynamic ‘Cure Rate
Start {Cjmin)  End (C/min)  Step (Cimin)  Colour ‘Weight Style: Marker
05 (o [ | [l — M[—B[ [
125 1.25 1.25 [ —v] | v | [vl [ [+
Min Temp: | 20 Max Temp: | 200 [ Add Segment ] [ Delete Segrment ]

10.3 Material Property Maps

Material property maps show contours of constant property values over the range of interest. The values used for these
maps can vary widely by material, and some trial and error may be required to obtain meaningful map values.
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General | Isothermal | Dynamic | Cure Rate |

Marker

Process Maps
Start {1/s) End (1)s)
le-4 le-3
le5 le-4
le-t 1e-5
Min Temp: | 20

. — ] ---[] v

(] [ —— [] [ —— ]|

]

v | v

I Add Segment ][ Delete Segment: l

Generate Maps

Chapter 10. Process Maps
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CHAPTER
ELEVEN

File Edit Data Ploks Tools Opkions window Help

Menu Commands

RAVEN has several standard menus for basic program interaction.

11.1 File Menu

Menu Item Action

New Create a new workspace (all existing simulations and
plots will be lost) (Ctrl-N)

Open... Open an existing workspace... (Ctrl-O)

Save Save the current workspace (Ctrl-S)

Save As... Save the current workspace as a new file...

Close Close the current workspace

Import... Import a workspace or CSV file

Page setup... Adjust the page setup for printing...

Print preview (current plot) Preview the print output

Print current plot... Print this plot... (Ctrl-P)

Exit Exit RAVEN

The File menu also contains a list of all recently opened workspaces.

11.2 Edit Menu

Menu Item Action

Cut Cut the currently selected item (Ctrl-X)

Copy Copy the currently selected item (Ctrl-C)

Paste Paste the item currently on the clipboard (Ctrl-V)

11.3 Data Menu

Menu Item

Action

New simulation...
Edit simulation...
Delete simulation...

Add new simulation...
Edit simulation...
Delete simulation...

In addition; when using Expert Mode, the following options are available:
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Menu Item

Action

New master analysis group...
Edit master analysis group...
Delete master analysis group...
New analysis group...

Edit analysis group...

Delete analysis group...

New query...

Edit query...

Delete query...

Create custom data...
Smooth results...

Thin results...

Add new master analysis group...
Edit master analysis group...
Delete master analysis group...
Add new analysis group...
Edit analysis group...

Delete analysis group...

Add new query...

Edit query...

Delete query...

Create a custom data column...
Smooth results...

Thin results...

11.4 Plots Menu

Menu Item Action

New plot... Add new plot...
Edit plot... Edit plot...
Delete plot... Delete plot...
New series... Add new series...
Edit series... Edit series...
Delete series... Delete series...

In addition; when using Expert Mode, the following options are available:

Delete master plot group...
New series group...

Edit series group...

Delete series group...

Menu Item Action
New master plot group... Add new master plot group...
Edit master plot group... Edit master plot group...

Delete master plot group...
Add new series group...
Edit series group...

Delete series group...

11.5 Tools Menu

Menu Item

Action

Cycle Editor
Materials Manager
Create Process Maps

Activate the Cycle Editor
Activate the Materials Manager
Create a new process map study

11.6 Options Menu

Menu Item Action
Preferences... Set the program perferences
Expert Mode Toggle expert mode
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11.7 Window Menu

Menu Item

Action

Show Feedback Window

Show the feedback window

This menu also contains standard options to arrange and switch between all available plot windows.

11.8 Help Menu

Menu Item Action

Help topics... View the RAVEN help

Tip of the day... View the RAVEN tips

Update license key... Enter a new license key

License Agreement... View the RAVEN license agreement

Check for Updates Check to see if an updated version of RAVEN is avail-
able

About... Additional information about RAVEN

Chapter 11. Menu Commands
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CHAPTER
TWELVE

Toolbar Commands

ARaE sLOD/#EBR| HLQAO(1QAQ
The main toolbar allows for creation of new runs, opening existing files, and manipulating plots. The actions available

on the toolbar include:

Button Function
#1 New Create a new workspace
Er Open Open an existing workspace

% Import Import an existing file...
Save Save the current workspace

« Cut Cut

-1 Copy Copy
[ Paste Paste

¢ New simulation Add a new simulation

=+ New query Add a new query
12 New plot Add a new plot

¢ Select Tool Selecting plot items (spacebar)

& Pan Tool Pan around the plot (p)

4 Zoom window Zoom the plot using a bounding box (z)
© Probe tool Used to extract data values at a specific point on a se-

ries

% 2 Zoom Extents Zoom to the extents of the data (x)

4 Zoom in Zoom the current plot in (+)

< Zoom out Zoom the current plot out (-)
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CHAPTER
THIRTEEN

Program Preferences

Selecting Preferences... from the Options menu will display the Preferences dialog.

Preferences

Linik Syskem
®s=1 Quscs

[ apply to all plats

[Jsave as default

[ 0K H Cancel ]

Setting the unit system will affect all plots set to use the default unit system. If the Apply to all plots checkbox is
checked, all existing plots will be changed to use the default unit system. In addition, if the Save as default checkbox
is checked, this unit setting will be saved for future RAVEN sessions.
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CHAPTER
FOURTEEN

Common Controls

14.1 Item Selection Dialog

The item selection dialog is used to select a variety of items in RAVEN. It is most often invoked by clicking on a
Source Breadcrumb link (or the corresponding ... button).

Select Results

Location: EBasic simulation of A54/3501-6 Prepreg > AS4/3501-6 Prepreg

= E Basic simulation of AS4/3501-6 Prepreg E

.7 |AS4/3501-6 Prepreg

The left side of the dialog displays the tree in which the required item exists. The right side of the dialog displays
the contents of the currently selected collection. When a valid selection has been made, the OK button will become
active. If the correct item type appears to be selected, but the OK button is greyed out, the selected item is an invalid
selection, as it will cause a circualar data reference if used for the intended operation.

14.2 Source Breadcrumb

A source breadcrumb is a link describing the location of the currently selected item. Hovering the mouse cursor over
the link (or the ... button) will provide a full-length location description. Clicking the link will allow selection of a
new source using an Item Selection Dialog.

Saource: . 4/3501-6 Prepreq » ... 4/3501-6 Prepreq E]

14.3 Checked Listbox Filter

A checked listbox filter allows quick selection of items within a checked listbox using simple string matching. If a
valid regular expression is detected in the filter box, it will be used to select items. Otherwise, all items with the
entered string somewhere in their name will be selected (case-insensitive).
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‘f-axis data:

Select

Colurnn Filter:

#-axis data:

Axis

Time M3 i

Temperature Rotate
Degree of Cure P
Cure Rate D

| Resin Modulus

v| Resin Poisson's Ratio

v Resin Inst. Cure Shrinkage Factor

| Resin Tnst. CTF [

resin

Time w1l w
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CHAPTER
FIFTEEN

License Agreement

Read this license carefully before proceeding. By indicating your acceptance of this license you acknowledge that
you intend to be legally bound by terms and conditions contained in this license. If you do not agree with these terms
and conditions, promptly remove this software from your computer and return the software and all related disks and
documentation (“Software”) to Convergent Manufacturing Technologies Inc. or its authorized reseller from whom
you purchased the product.

This Software License is granted by Convergent Manufacturing Technologies Inc. (“CONVERGENT”), to the end
user (the “Licensee”) on the following terms and conditions:

1. Grant of License

The Licensee is granted the non-exclusive non-transferable right to use the RAVEN composite structure process
modeling software (the Software) and associated documentation (the Documentation) on a single computer at
the location specified by the Licensee and approved by CONVERGENT.

2. Ownership

CONVERGENT retains all property, right, title and interest in and to the Software and Documentation, includ-
ing, without limitation, all trade-marks, trade names, copyrights, patents and other intellectual property rights in
the Software and Documentation. CONVERGENT specifically retains the right to grant licenses of the Software
and Documentation to other persons.

3. Copy and Use Restriction

Software to a new machine, the Licensee shall first remove the installed Software. The Licensee shall reproduce
and include the copyright notice of CONVERGENT on any and all copies, whether in whole or in part, in
any form. The Licensee will not modify, adapt, translate, reverse engineer, decompile, disassemble or create
derivative works based upon the Software or Documentation without the written permission of CONVERGENT.

4. Transfer Restriction

This License is in force for one year from the date of purchase, as indicated by the date on the shipping docu-
mentation. This License may be renewed automatically by payment of the designated annual license fee. This
License will be terminated automatically if the Licensee fails to abide by any provisions of this Agreement, fails
to renew the License at the end of one year, or if any petition, assignment or proposal is made against or by
the Licensee under any Bankruptcy Act or if the Licensee is adjudged bankrupt, or makes an assignment for the
benefit of his/its creditors. Upon termination, the Licensee shall return to CONVERGENT or destroy all copies
of the Software and Documentation at the discretion of CONVERGENT.

5. Termination

This License is in force for one year from the date of purchase, as indicated by the date on the shipping docu-
mentation. This License may be renewed automatically by payment of the designated annual license fee. This
License will be terminated automatically if the Licensee fails to abide by any provisions of this Agreement, fails
to renew the License at the end of one year, or if any petition, assignment or proposal is made against or by
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10.

the Licensee under any Bankruptcy Act or if the Licensee is adjudged bankrupt, or makes an assignment for the
benefit of his/its creditors. Upon termination, the Licensee shall return to CONVERGENT or destroy all copies
of the Software and Documentation at the discretion of CONVERGENT.

Up-date Policy

CONVERGENT may produce, from time to time, modifications and/or updates of the Software and/or Docu-
mentation. Such modifications and updates may be made available at the discretion of CONVERGENT to the
Licensee.

Support

CONVERGENT shall provide technical support under this License. The extent and nature of this technical sup-
port is at the sole discretion of CONVERGENT. Additional support may be purchased separately by contacting
CONVERGENT.

Non Warranty

CONVERGENT makes no representations or warranties, either express or implied, with respect to the Software
and specifically disclaims any implied warranty of non-infringement or merchantability or fitness for a particular
purpose. CONVERGENT shall in no event be liable for any loss of profits, be they direct, consequential,
incidental, or special or other similar or like damages arising from any defect, error or failure to perform with
respect to the Software, even if CONVERGENT has been advised of the possibility of such damages. The
Recipient hereby acknowledges that it has been advised by CONVERGENT to undertake its own due diligence
with respect to the Software.

Limitation of Liability

In no event shall CONVERGENT be liable for special, indirect or consequential damages, including those
damages arising from lost profits in the use or misuse of the Software and/or Documentation, even if CONVER-
GENT has been advised of the possibility of such damages.

Miscellaneous

a. This License shall be governed by and construed in accordance with the laws of the Province of British
Columbia, Canada.

b. This License contains the entire agreement and understanding between the Licensee and CONVERGENT
with respect to the subject matter hereof and supersedes any prior agreement or understanding whether oral or
written, relating to the subject matter of this License. This License may only be modified by a written agreement
signed by both parties.

This software is intended to assist with the process design and is not a substitute for independent testing of
a product’s stress, safety and utility. CONVERGENT does not warrant the accuracy of the results obtained
through use of the program.

The terms and conditions as stated herein are accepted, agreed to and acknowledged.
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